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Good Morning!  
Day 2 

 
 
You are on your own this morning to complete the 
daily morning activities: diary writing and email. 
Beginning today, you will also need to look at the 
“site of the day.”  The sites of the day are 
favorite sites for educators providing you with 
excellent teaching resources. 
 
 
1.  Check your E-mail: 
 
2.  Open your journal template: 

 Locate the journal template and double click on it to open it. 
 Respond to the diary question in the slide show. 
 Print 2 copies. Put one in your group folder and one in your notebook. 
 Save your document as “Day 2 Diary” in your folder. 

 
3. View the “site of the day” How could you use this in your classroom? 
 
 

" Can't died when Could was born."
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Comparing Rainforest Countries? 
 

Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction: 
Essential Questions for Teachers: How can I use cooperative grouping with 
technology? How can I use specific Web sites to deliver information to my 
students? How do I use Microsoft Word to create a poster?  How do I 
manage the multiple computer classroom? How do I use drawing tools in MS 
Word? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: In what ways are the countries where 
rainforests located similar? What economic, historical, 
geographic, or cultural items do they share? How can we save the 
rainforest and help the country prosper as well? 
 
Learning Standards (State of Michigan): 
Assessed:  
Social Studies Standards  
Organize social science information to make maps, graphs, and 
tables. 
 
Gather and analyze information using appropriate information 
technologies to answer the question posed. Construct an answer 
to the question posed and support their answer with evidence.  
Report the result of their investigation including the procedures 
followed. 
 
All students will describe, compare, and explain the locations and 
characteristics of ecosystems, resources, human adaptation, 
environmental impact, and the interrelationships among them. 
 
English/Language Arts Standard 3: Later Elementary 
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts. An example is using 
all the language arts to prepare and present a unit project on a 
selected state or country. 
 
Materials: Inspiration, Microsoft Excel, Microsoft Word, Scan 
Converter, student reproducibles, Internet connection  
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Whole 
Group 
Instruction 
 
 
 
 
 
 
 
Expert 
Groups  
 
For more 
ways to use 
Cooperative 
Learning in 
your 
classroom 
see:  
Cooperative 
Learning 
Activities 
http://204.1
84.214.251/
coop/ecoop
main.html  
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
http://geogra
phy.about.com
/library/blan
k/blxindex.ht
m 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
http://www.i3
forteachers.c
om/developin
gnations.htm 
 
 
 
 
 
 

Technology Connections: Students will research information on 
the Internet.  Following this activity, they will create a graph in 
Microsoft Excel, make a poster, and write a summary in 
Microsoft Word. 
 
Procedures: 

1. Write the words economist, geographer, 
environmentalist, historian, and zoologist on the board.  
Have students explain the jobs of each, adding more 
information when necessary. Use dictionary.com to 
explore the definitions whole group.   Explain that the 
class will be divided into groups and conduct research 
based on their specific assignment. Each group member 
will have a different assignment.   

 
2. Divide students into groups by using the following 

activity.  Prior to the lesson, print the cards with the 
country name and job assignment on them.  Make sure 
that you have exactly the number of pieces needed for 
your students.  If you have a number that is not 
divisible by 5, you may have to take a role.  Give each 
student a piece of one of the puzzles.  When you give 
the signal, students will try to find the other two 
students that they need to complete their country 
puzzle.  The groups will be referred to by the country 
name on their puzzle. 

 
3. Assign a geographer, environmentalist, historian, 

economist and zoologist in each group. Each student is 
to become an “expert” in his or her field. Provide 
worksheets for each expert. 

 
4. Allow individual students to visit the site on the 

Internet 
(http://www.i3forteachers.com/developingnations.htm .  
They will follow the directions to find information for 
their specific area and record their answers on the 
fact-gathering sheet. 

 
5. After students complete their “scientist” information 
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Individual 
Work 
 
 
 
 
 
 
 
Expert 
Groups 
 
 
 
 
 
 
 
 
 
 
Individual 
Work 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 

sheet they are to meet with other students who hold 
the same job from a different a country.  They then 
share and compare information about the discoveries 
they made. Students will use the Venn diagram to 
compare the information and find differences and 
similarities.  

 
6. Students then gather back into their country teams 

and share their information with the other scientist 
from their country.  They record their shared 
information on the group data collection sheet.  

 
7. Students then attempt to answer the essential 

questions. If they can’t, they need to determine what 
further information is needed to answer these 
questions. 

 
8. Each student is to then make a poster in Microsoft 

Word or Publisher showcasing the information they 
learned about their country.  

 
9. Give students the opportunity to share their completed 

posters with the class.  Before students share their 
presentation, go over the criteria on which they will be 
graded.  Evaluate each student’s presentation with the 
rubric. 

 
Assessment: Assess students’ presentations according to the 
rubrics.   
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Brazil 
Job Assignment: Economist 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  
Click on job under the country you were assigned. Use the information included on 
the sites to answer the following questions. 

 
1. What are the major exports produced by this country? Which are derived from the 

rainforests?  
 
 
 
 
2. In what industries are people employed in Brazil? Give % for those you list.  
 
 
 
 
 
3. What is the unemployment rate for your country?  
 
 
 
 
4. What is the poverty rate?  
 
 
 
 
5. What was the tourism rate in 2000? 
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Brazil 
Job Assignment: Geographer 

 
 

Directions:   
Go to the Developing Nations Project site. 

http://www.i3forteachers.com/developingnations.htm 
  
Click on job under the country you were assigned. Use the information included on 
the sites to answer the following questions. 

 
1. How big are the Brazilian rainforests? 

 
2. What percent of the land is rainforest? 

 
3. Label the following on the map below:  rainforest areas, Amazon River, Brasilia, 

North Atlantic, South Atlantic, Balem and Manus. 
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Brazil 
Job Assignment: Zoologist 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  
Click on job under the country you were assigned. Use the information included on 
the sites to answer the following questions. 
 

Rainforest Animals 
1. Record the class, diet, and conservation status. 

Animal Class Diet Conservation status 
 
 
 

   

 
 
 

   

 
2. What animals are endangered in your country as a result of rainforest 

destruction? 
 
 
 
 
 
3. Are any species in danger of extinction? If so which ones and why? 
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Brazil 
Job Assignment: Historian 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  

Click on job under the country you were assigned. Use the information included on the 
sites to answer the following questions. 
 

1. What is the current type of Government? How many states is it composed of? 
 
 

2. Has the type of Government changed in the recent past? (Last 100 years) If so 
how? 

 
 
 
 
 
 
 

3. What are the primary ethnic groups in %?  
 
 
 
 
 
 

4. What are the primary religions in %? 
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Brazil 
Job Assignment: Environmentalist 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  

Click on job under the country you were assigned. Use the information included on the 
sites to answer the following questions. 
 

1. How has the logging industry threatened the rainforest in your area? How much 
of the rainforest has been affected so far? 

 
 
 
 
 
 

2. Why is logging a problem? 
 
 

 
 
 
 
 
 

3. What people are threatened by changes to the Brazilian rainforest? What 
changes are threatening them? 
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Cameroon 
Job Assignment: Economist 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  
Click on job under the country you were assigned. Use the information included on 
the sites to answer the following questions. 

 
1. What are the major exports produced by this country? Which are derived from 

the rainforests?  
 
 
 
 

2. In what industries are people employed in Cameroon? Give % for those you list.  
 
 
 
 
 

3. What is the unemployment rate for your country?  
 
 
 
 

4. What is the poverty rate?  
 
 
 
 

5. What was the tourism rate in 2000? 
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Cameroon 
Job Assignment: Geographer 

 
 

Directions:   
Go to the Developing Nations Project site. 

http://www.i3forteachers.com/developingnations.htm 
  
Click on job under the country you were assigned. Use the information included on 
the sites to answer the following questions. 

 
  1. How big are the Cameroonian rainforests? 

 
 2. What percent of the land is rainforest? 

 
Label the following on the map below: rainforest areas, Yaounde, Douala, and the 
Atlantic ocean. 
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Cameroon 
Job Assignment: Zoologist 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  
Click on job under the country you were assigned. Use the information included on 
the sites to answer the following questions. 

 
Rainforest Animals 

1. Record the class, diet, and conservation status. 
Animal Class Diet Conservation status 

 
 
 

   

 
 
 

   

 
2. What animals are endangered in your country as a result of rainforest 

destruction? 
 
 
 
 
 

 
3. Are any species in danger of extinction? If so, which ones and why? 
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Cameroon 
Job Assignment: Historian 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  

Click on job under the country you were assigned. Use the information included on the 
sites to answer the following questions. 
 

1. What is the current type of Government? How long has it been in place? 
 
 
 
 

2. Which two European countries controlled Cameroon after WWII? 
 
 
 
 

3. What are the primary ethnic groups in %?  
 
 
 
 
 
 

4. What are the primary religions in %? 
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Cameroon 
Job Assignment: Environmentalist 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  

Click on job under the country you were assigned. Use the information included on the 
sites to answer the following questions. 
 
 

1. How has the logging industry threatened the rainforest in your area? 
 
 
 
 
 

2. What other threats are there to the rainforest in your area? 
 
 
 
 

3. What percent of the rainforest has been affected so far by this industry? 
 
 
 
 

4. What people are threatened by changes to the Cameroonian rainforest? 
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Indonesia 
Job Assignment: Economist 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  
Click on job under the country you were assigned. Use the information included on 
the sites to answer the following questions. 

 
1. What are the major exports produced by this country? Which are derived from 

the rainforests?  
 
 
 
 

2. In what industries are people employed in Indonesia? Give % for those you list.  
 
 
 
 
 

3. What is the unemployment rate for your country?  
 
 
 
 

4. What is the poverty rate?  
 
 
 
 

5. What was the tourism rate in 2000? 
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 Indonesia 
Job Assignment: Geographer 

 
 

Directions:   
Go to the Developing Nations Project site. 

http://www.i3forteachers.com/developingnations.htm 
  
Click on job under the country you were assigned. Use the information included on 
the sites to answer the following questions. 

 
1. How big are the Indonesian rainforests? 

 
2. What percent of the land is rainforest? 

 
3. Label the following on the map below: rainforest areas, Jakarta, Java, Sumatra, 

Kalimantan, Indian Ocean, and the Pacific Ocean. 
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 Indonesia 
Job Assignment: Zoologist 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  
Click on job under the country you were assigned. Use the information included on 
the sites to answer the following questions. 

 
Rainforest Animals 

1. Record the class, diet, and conservation status. 
Animal Class Diet Conservation status 

 
 
 

   

 
 
 

   

 
2. What animals are endangered in your country as a result of rainforest 

destruction? 
 
 
 
 
 
3. Are any species in danger of extinction? If so which ones and why? 
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 Indonesia 
Job Assignment: Historian 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  

Click on job under the country you were assigned. Use the information included on the 
sites to answer the following questions. 
 

1. What is the current type of Government? How long has it been in place? 
 
 
 
 

2. Which two European countries controlled Indonesia after WWII? 
 
 
 
 

3. What are the primary ethnic groups in %?  
 
 
 
 
 
 

4. What are the primary religions in %? 
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 Indonesia 
Job Assignment: Environmentalist 

 
Directions:   

Go to the Developing Nations Project site. 
http://www.i3forteachers.com/developingnations.htm 
  

Click on job under the country you were assigned. Use the information included on the 
sites to answer the following questions. 
 

1. How has the paper industry threatened the rainforest in your area? 
 
 
 
 
 

2. What percent of the rainforest has been affected so far by this industry? 
 
 
 
 
 
 
3. What people are threatened by changes to the Indonesian rainforest? 

 
 
 
 

 
 



Technology Tools in the Secondary Social Studies & Language Arts Classroom       

   

Copyright © 2001-2006  i3 Inc.                         inspiring, innovative, instruction                                                       Day 2                      

20

 
 
 

 
Collect information from your fellow scientists about their discoveries. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Collect information from your fellow scientists about their discoveries. 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

Scientist-  

Facts- Minimum of 3 facts 
 

Scientist-  

Facts- Minimum of 3 facts 
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Collect information from your fellow scientists about their discoveries. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Collect information from your fellow scientists about their discoveries. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Scientist-  

Facts-Minimum of 3 facts 
 

Scientist-  

Facts-Minimum of 3 facts 
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Work with your team to answer these questions 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

In what ways are the countries where rainforests are located similar? What economic, 
historical, geographic, or cultural items do they share?

 
 

What conflicts do you see arising from the need to preserve rainforest land as well as 
produce income from this land? 
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Country Fact Sheet 
 
 

  Name of your country: ____________________________________________ 
 
  Type of Government: ______________________________________________ 
  
  Primary Religions: ________________________________________________ 

 
  Primary Ethnic Groups: ____________________________________________ 
 
 
 
Collect the answers to the questions below for your poster project. 
 
Fact #1 
What are the major exports produced by this country? 
 
 
Fact #2 
What was the tourism rate in 2000? 
 
 
Fact #3 
What people are threatened by changes to the rainforests in your 
country? Why are they being threatened? 
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Country Poster Rubric 
 
Name _______________ Date _______________ 
 

 The poster included at least three detailed facts about the assigned country. 

 Student can accurately answer all questions related to facts in the poster and 

processes used to create the poster. 

 The poster was easy to read and made sense. 

 The poster was edited for punctuation, spelling, and grammar mistakes. 

 The poster includes a map and graphic of the countries flag. 

 Graphic sources were cited. 

 
Teacher Comments: 
 
 
 
 
 
 
Student Comments: 
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Country Research Presentation Assessment 
 
Name ____________________ Date ____________ Score ______________ 
Scale: 
4= job is well done; exceeds requirements 
3= job is adequate; meets requirements 
2= only partially accomplishes task; needs revision 
1= needs to restart; meets little or none of the requirements 
 
Oral 
Good eye contact. 
1  2  3  4 
 
People in the back of the room could hear. 
1  2  3  4 
 
Shows enthusiasm. 
1  2  3  4 
 
Mechanics 
Basic grammar rules applied. 
1  2  3  4 
 
Logical sequence of ideas and events. 
1  2  3  4 
 
Information is supported by relevant facts. 
1  2  3  4 
 
Poster 
Accurately explains the material on the poster. 
1  2  3  4 
 
Used the poster as a prop and for talking points. Did not read directly from the poster. 
1  2  3  4 
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 Venn Diagram Steps 
Setting Up 
• Open Microsoft Word. 
• Change the page layout. 
• Click on the File menu and select page setup. 
• Click on the Paper size tab. 
• Under Orientation, click the bullet box beside Landscape. 
• Click OK. 
• Change the Zoom. 
• Click the drop down list indicator beside 75% on the right side of the toolbar.   
• Select 50%. 
• Make sure your drawing tool bar is showing. 
• Click on the View menu and select Toolbars. 
• If Drawing is not checked, click on Drawing.  If it is, click off. 
 
Making the Venn diagram 
• Draw a circle 
• Select the Oval tool on the drawing toolbar. 
• Hold the shift key while clicking and dragging a circle on the left half of the page. 
• Make a copy for a matching circle. 
• Click once on the circle to select it.  (It will have handlebars if it is selected.)   
• Right click and select copy. 
• Click off of the circle.  Right click and select paste. 
• Move the new circle over to the right of the page by clicking and dragging so that 

the new circle overlaps the original, allowing room to enter similarities in the 
overlapping area. 

• Set the Circle for No Fill. 
• Right click on the Right circle. 
• Select Format AutoShape. 
• Under Fill, beside Color: Use the drop down list indicator and select No Fill. 
• Click OK. 
• Draw lines for each animal name. 
• Select the line tool from the Drawing toolbar. 
• Hold Shift while you click and drag a straight line just outside of the upper left of 

the left-hand circle. 
• With the line selected (handlebars on each end of the line) click the Edit menu and 

select copy.  Click again on the edit menu and select paste. 
• Click and drag the new line just outside the upper right of the right-hand circle. 
• Add text boxes. 
• Select the Text Box tool from the Drawing toolbar. 
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• Click and drag a text box above each label line, in each individual circle, and in the 
shared area.  Set the font style and size of your choice in each box.  (You will have 
to re-select the text box tool each time.) 

• Right click on the edge of each text box and select Format Text Box. 
• Under the line section on the Colors and Lines tab, change the color to No Line.  
• Click OK. 
• Add labels at the bottom of the diagram. 
• Again select the text box tool from the Drawing toolbar. 
• Draw a text box under the left circle. 
• Set the font style and size and type “Different.” 
• Right click on the edge of the new text box.  Set the line color to No Line. 
• Draw 2 more text boxes; One for the middle section which will be “Same” and the 

other for the right-hand circle which will be “Different.” 
• Save the Venn Diagram as a template. 
• Click on the File menu and select Save As. 
• Change Save as type to Document Template. 
• Change the file name to Venn Diagram. 
• Change the location to 3 ½ Floppy (A:) 
• Click Save. 
• Close out of Microsoft Word. 
 
Using the Venn Diagram Template 
• Open the Venn Diagram Template to enter information. 
• Double click on My Computer. 
• Double click on 3 ½ Floppy (A:). 
• Double click on Venn Diagram.dot. 
• Click in the appropriate area to enter information. 
• Save the new Document. 
• Click on the File menu and select Save. 
• Type in the name for the completed Venn Diagram. 
• Change to the appropriate drive and folder. 
• Click Save. 
• Close out of Microsoft Word. 
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Internet Island 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers:  How do I teach Internet search strategies 
to my students?  How do I save a graphic from the Internet?  How do I copy 
text into an e-mail document? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: How do I find information on the Internet? 
How do I use a graphic from the Internet in a poster about my 
country? 
 
Learning Standards (State of Michigan): 
Social Studies Standards 
All students will conduct investigations by formulating a clear 
statement of a question, gathering and organizing information 
from a variety of sources, analyzing and interpreting information, 
formulating and testing hypotheses, reporting results both orally 
and in writing, and making use of appropriate technology. 
 
All students will acquire information from books, maps, 
newspapers, data sets, and other sources, organize and present 
the information in maps, graphs, charts, and time lines, interpret 
the meaning and significance of information, and use a variety of 
electronic technologies to assist in accessing and managing 
information. 
 
English/Language Arts Standards 
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts. An example is using 
all the language arts to prepare and present a unit project on a 
selected state or country. 
 
Using multiple media, develop and present a short presentation to 
communicate conclusions based on the investigation of an issue or 
problem. Examples include charts, posters, transparencies, audio 
tapes, videos, and diagrams. 
 
 
 
Materials: student reproducibles, Internet connection,  
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Partner 
Activity 
 
 
 
 
 
Partner 
Activity 
 
 
Individual 
Work 
 
 
 
 

 
 
 
 
 
Internet- 
http://www.m
iamisci.org/ii/
ii0.html 
 
 
 
 
 
E-mail 
 
 
 
 
 
Other ways 
to integrate 
the Internet 
in your 
classroom 
http://7-
12educators.a
bout.com/libr
ary/weekly/a
a040300a.ht
m?terms=Int
ernet+integra
tion 
 
 
 
 

Technology Connections: Students will learn how to use the 
Internet by going through an on-line tutorial.  They will combine 
their research with a web graphic to create a teaching poster 
with information about their country. 
 
Procedures: 
1. Introduce basic Internet skills and search strategies by 

visiting Internet Island (http://www.miamisci.org/ii/ii0.html). 
Assign students a partner and give them each a fact-
gathering sheet.  Get them started on Internet Island and 
allow them to take themselves through the tour, following 
directions on the site and the fact-gathering sheet. 

2. When students get to the story ending form, have each 
student complete the form individually.  Before clicking on 
submit, ask students to copy and paste the story ending into 
an e-mail document and send it to their partner.  Partners will 
use the story ending to complete a Venn diagram, comparing 
the two story endings. 

 
Assessment: Students will be assessed on their completed 
posters using the rubric. 
 
Extension: Ask students to become teachers and plan a lesson 
for the class, teaching them about their ocean animal.  Students 
can use their poster as a graphic aid during their lesson. 
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Visit Internet Island 
http://www.miamisci.org/ii/ii0.html 

 
 

During your visit to Internet Island you will learn 
about Marine Biology and the Internet.  Find the 
answers to these questions as you work your way 
through the site. Write the definition of each 
Internet term and then answer the related 

questions. 
 
 
Hyperlink- 
 

Would you want to meet up with a Spotted Scorpionfish?  Why or Why not? 
 
 
 
 
 

Clickable Picture- 
 
How does a Porcupine fish defend itself? 
 
 
 
 
How does a Decorator Crab hide from predators? 
 
 
 
 
Write the names of two kinds of plants found in the Safari Touch Tank. 

 
 
 
 
 
 
 



Technology Tools in the Secondary Social Studies & Language Arts Classroom       

   

Copyright © 2001-2006  i3 Inc.                         inspiring, innovative, instruction                                                       Day 2                      

32

 
Search Tool- 
 

Do a search for squid and visit several of the links to find information about 
these sea creatures.  Write down 5 facts that you learned about squid. 

 
 
 
 
 
 
 
 
 
 
Hotlist- 

 
Visit the Birch Aquarium.  When you get there, click on the pull-down menu in the 
upper right hand corner of your screen that says “Quick Link”.  Click and drag 
down until you reach “Dive into Science…Sharks”.  Read the information about 
sharks and write down 5 facts that you learned. 

 
 
 
 
 
 
 
 
 
 
Gopher- 
 
Forms- 
Write your story ending.  Before you click on submit, copy and paste 
your story ending into an e-mail document and send it to a peer.  
Read another classmate’s story ending and contrast your ending with 
theirs in the Venn Diagram. 
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Guide to TrackStar 
TrackStar home page: http://trackstar.4teachers.org 

To Find A Specific Track 

1. If you know the number of the Track, type in the Track's number in the field 
(blank space) next to View Track # located under the Find a Track column on 
the TrackStar home page. This is the easiest way to direct students to a Track 
or set of Tracks. 

2. If you know the author, choose Search Tracks by Author link on the TrackStar 
home page, then fill in the author's last name or e-mail address. Click on Find 
Tracks and wait for the results page. Be sure to use upper and lower case for this 
search (e.g., John Smith not john smith) 

3. If you know the topic (e.g., ancient egypt), choose Search Tracks by Keyword 
link on the TrackStar home page, then type the word or phrase (e.g., "ancient 
egypt") into the form. Narrow your search by choosing subject, grade, format, or 
award. Click Find Tracks and wait for the results page. Using lowercase makes it 
more likely you will find all the Tracks that include this word or phrase for the 
grade levels chosen (e.g., "ancient egypt" not "Ancient Egypt"). Be sure to use the 
search instructions at the right-side of the Keyword search page to get the best 
results. 

 
To Find Thematic Tracks 

1. If you want Tracks that relate to a particular academic theme that may have 
many keywords associated with it (e.g., Western Expansion), choose Browse 
Themes and Standards. Click on the subject and grade level desired (e.g., Social 
Studies, grades 5-8) and wait for the results page. You will be given a listing of 
themes in the left-hand frame. Click on the desired one (e.g., Western Expansion) 
and a listing of pertinent Tracks will be placed in the large frame to the right. 
You can also see State academic standards associated with this theme by clicking 
the State tab (e.g., Kansas) in the upper right-hand frame. This will help you 
select Tracks that fit your State's academic standards. 
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2. If you want to see Tracks that relate to specific holidays that have been 
selected and/or written by HPR*TEC staff, choose See This Month's Track-A-
Day. By each day of the month is a link to a Track that is related to a holiday. 
Most of the Tracks are related to holidays described in the Knowledge 
Adventure's Month By Month software in order to assist teachers using this 
series. 

 
To Find Exemplary Tracks 

1. If you want Tracks that have been selected by HPR*TEC staff as exemplary 
Tracks, choose See All Top Tracks link on the TrackStar home page. 

2. If you want to find Tracks, WebQuests, and Web sites that have been selected 
by HPR*TEC as useful for teaching specific subject matter (e.g., Colonial 
literature), go to http://4teachers.org/ and select the R*TEC Teacher link 
under the Tools for Teachers section in the right-hand column. This will open a 
page with a pulldown menu. Click the select a subject, then continue narrowing 
your search by selecting a theme, and finally a topic. You will obtain a list of 
several Tracks, WebQuests, and Favorite Links for that specific topic.  

 
To Use A Track 

1. When you select a Track using a hyperlink, the Track number, or by typing in the 
URL, you will find yourself at the Description page of the Track. This page 
describes what the Track is about, and has buttons entitled View in Frames and 
View in Text for viewing the Track.  

2. For student use, we recommend the Frames version. Click on the View in Frames 
and you will be taken to the material in the Track. Many teachers start their 
students with the Frames view already open. The lower right-hand portion of the 
window (frame) will always show the first site when you open the Track. To 
change the site, click on one of the links listed in the left-hand frame (Navigation 
frame). Notes related to the site being displayed are found in the upper right-
hand frame (Annotation frame). They will change as you click on the links. This 
area will also provide the correct URL for the site being displayed. If you wish to 
reference (cite) a site found within a Track, always use the URL provided in this 
Annotation frame. 

3. To review a Track quickly, print a Track, or use a screen-reader, use the Text 
version. Choose Print from your browser menu bar and you can print this page. 
Clicking on the links will load the sites. Use the Back button on your browser to 
get back to the Text page.  



Technology Tools in the Secondary Social Studies & Language Arts Classroom       

   

Copyright © 2001-2006  i3 Inc.                         inspiring, innovative, instruction                                                       Day 2                      

36

 
To Make An Instructional Track 

1. First be sure that you have located several Web sites you wish to feature in your 
Track. You can feature no more than 15 sites within a Track. These sites should 
be related to a topic you are teaching. You will need to know the title of each site 
and its URL (Web address). You will also want to plan the sequence of these sites. 
Last, you should think about what you want the student to do at each site. If they 
are to answer specific questions, you may want to plan those questions before 
beginning the Track.  

2. If you want to make a quiz or Web page to include in your Track, you should do 
this prior to making the Track. Be sure you know the full URL (beginning with 
http://…) of these pages prior to beginning the Track. Take the Make A Quiz or 
the Build A Web Page link from the TrackStar home page to make a quiz or Web 
page. 

3. Click Login to Make or Edit a Track on the TrackStar home page.  
4. On the Login page, either register (if you have never made a Track before and do 

not have an account) or login. You will need to remember your e-mail and password 
to edit your Track or to create others, so be sure you write it down and keep it 
somewhere safe. This information will not be sold and does not obligate you to 
anything. TrackStar is a free service. 

5. When you login by filling in the blanks and clicking either the Register or Login 
button, depending on which you did, you will be taken to your My Account page.  

6. The My Account page lists all the Tracks you have made. Above this list, click on 
the Make New Track link.  

7. Use the Help link on the top of all TrackStar pages if you have trouble filling out 
the form. Otherwise, just click in a box (field) and type in the Track title, 
description, type, subject area, and grade level. You may also choose to enter a 
Due Date or Password, if you wish. 

8. Be sure you are careful when you choose the grades and subjects for your Track. 
This will help other teachers find the Tracks they need. 

9. At the end of this form, click the Next button. 
10. Now simply click in the title field and type the title of the first site you wish to 

include in your Track. Then click in the URL field and type (or copy and paste) the 
URL for that site. Then click on the Annotation field and type any instructions or 
descriptions you wish to provide the students related to this first site. Continue 
doing this until all your sites are included in the Track. Then scroll to the bottom 
of the form and click Save. Wait for the Confirmation page to appear. It will give 
you the Track number and the full URL. You can view the Track immediately by 
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clicking on the link on the Confirmation page. Be sure you know the number of 
your Track. You and your students can use this number to find the Track quickly. 

11. Read the Tutorial on the TrackStar home page if you wish to see step-by-step 
detailed instructions.  

 
To Edit or Delete Your Own Track 

1. If you wish to edit your Track, choose Login to Make or Edit a Track link from 
the TrackStar home page. 

2. Login by typing in your e-mail address and password and click the Login button. 
3. Look for the Track's title on your personal My Account page. Next to the title is 

an Edit link represented by a pencil and a Delete link represented by a red "x". 
Click on either the pencil to Edit the Track or the red "x" to Delete the entire 
Track including all its sites and annotations.  

4. If you choose Delete, you will be asked to confirm that you want to delete the 
entire Track.  

5. If you choose Edit, the form with all the data from your Track will be generated.  
6. Make any corrections to the Track. Correct typos, change URLs, titles or 

annotations, or delete sites. It works like a word processor. Simply click or select 
the part you wish to change and type the correction. To delete a site from your 
Track, simply click the red "x" next to that link. Click on Preview, represented by 
a magnifying glass, beside a link if you want to check the link. When you have 
made all your corrections, scroll to the bottom of the page and click the Save 
button. 

7. Read the Tutorial on the TrackStar home page if you wish to see step-by-step 
detailed instructions.  
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Integrating the Internet into your Curriculum 
 
Make a plan 
The easiest way for you to begin using the Internet with their students is to integrate 
it into your tried and true lesson plans.  Use plans that you have taught before and you 
know are successful on their own merits, regardless of the Internet component.  This 
way, if everything doesn’t go right your plan will still be successful.   
Look for plans that involve: 

 Research on a particular topic 
 Comparing and contrasting information 
 A multicultural or country study 
 Researching and writing a report 
 Using graphics and art 
 Collecting and analyzing data 
 Making a presentation 

 
Search for the Right Site 
The only way to find the perfect site to fit a particular lesson is to get out onto the net 
and search.  While searching the net, it’s best to explore all links to avoid dead-ends or 
discovering inappropriate material.  Since the World Wide Web is always changing, don’t 
abandon a topic because you were unable to find any information on it today.  Go back in 
another month and you may discover a new site that wasn’t there before. 
 
Every lesson needs to have a component that assesses student learning.  Internet 
lessons are no different.  Having students search the Internet for pieces of information 
that they do nothing with is unproductive and a waste of time.  Make sure you 
incorporate some way of evaluating their learning into your lesson plans. 
 
Using the Internet as a teaching tool involves planning and preparation.  Go through the 
following checklist before you present your Internet lesson to ensure that you are 
prepared. 
 

 •  Have you selected a safe and relevant site? 
 •  Have you created bookmarks for your students? 
 •  Have you double-checked to make sure the sites are working? 
 •  How will you assess their learning? 
 •  Have you provided instruction about using the Internet and search strategies? 
 •  Have you made sure that you have the necessary plug-ins? 
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Internet Helper 
Internet Safety Tips for Kids 

 
• Do not give personal information such as your address, telephone number, parent’s 

work address or telephone number, or the name and location of your school. 
 
• Tell your parents if something that you come across online makes you feel 

uncomfortable. 
 
• Never agree to get together with someone you “meet” online without your parent’s 

permission. 
 
• If your parents agree to the meeting, be sure the meeting is in a public place and 

that you bring them along. 
 
• Never respond to messages or bulletin board items that are suggestive, obscene, 

belligerent, threatening, or make you feel uncomfortable. 
 
• Give a copy of such messages to your parents and have them forward it to your 

Internet service provider. 
 
• Never send pictures of yourself or any other personal material to a friend you meet 

online without telling your parents first. 
 
• Follow the rules that your parents set for your online activities. 
 
• There are places on the Internet that are for adults only.  If you find yourself in one 

of those areas LEAVE and go to one of the cool places on the Internet for kids. 
 
• Don’t give out personal information about your family situation, school, telephone 

number, or address. 
 
• If you become aware of the transmission, use, or viewing of child pornography while 

online immediately report this to the US Customs Cyber Smuggling Center at 1-800-
BE ALERT or email icpicc@customs.treas.gov. 

• When chatting in chat rooms, remember that not everyone is who they say they are, 
for example, a person who says “she” is a 14 year old girl from New York may really 
be a 42 year old man from California. 
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• If someone harasses you online, says anything inappropriate, or does anything that 
makes you feel uncomfortable, contact your Internet service provider. 

 
Tips for Parents 
 
• Learn about computers so you can monitor your child’s use. 
 
• Spend quality time with your children, thereby preventing them from depending on 

computer technology for recreation, communication, and companionship. 
 
• Keep the computer in a common area of the house. 
 
• Don’t EVER allow a child to give out personal information on-line, not real name, 

address or telephone number. 
 
• Don’t allow a child to meet someone they have met on-line face-to-face. 
 
• Remember that people on-line may not be who they seem.  A “12 year old girl” may 

actually be a 40-year-old man. 
 
• Though they are not fool proof, consider purchasing and installing a pornography 

blocking software package such as CYBERsitter, SurfWatch, Cyber Patrol, Rated-PG 
or Net Nanny. 

 
• Periodically check the Web sites your children are visiting and look at the files they 

are storing. 
 
• If you become aware of the transmission, use, or viewing of child pornography while 

online immediately report this to the US Customs Cyber Smuggling Center at 1-800-
BE ALERT or email icpicc@customs.treas.gov. 
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Google Advanced Search 

 

Getting Started 
To Open the 

Advanced Search 
Window 

• Click on Advanced Search on www.google.com. 
• The top four fields in the blue box replace Boolean searches. So 

instead of having to construct searches using the + or – symbols, 
Google’s Advanced Search fields performs those functions. 

 
To Broaden a Search • In the search field next to “with all of the words” type the word(s) 

you wish to search for and then press Google Search. 
• Google will return pages with all the terms you list in the search 

results. 
• Another option would be to put the main term in the top field and 

then list possible additional terms in the field next to “with at least 
one of the words”. 

• In this case Google will look for the top term and include as many of 
the other terms as possible in the search results. 

 
To Narrow a Search • In the search field next to “with all of the words” type the word(s) 

you wish to search for and then press Google Search. 
• In the field next to “without the words” type the words that should 

be excluded from the search, then press Google Search. 
 

To Search for a 
Phrase 

• In the field next to “with the exact phrase” type the phrase you 
wish to look for and then press Google Search. 

• Google will conduct a complete text search looking for the words in 
the phrase. 

Interpreting Search Results 
Indented Results • If more that one page from a site fits the search criteria, the 

most relevant page is listed first with the other pages indented 
and listed below it. 
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Viewing Missing Web 
Pages 

• Google’s search results include the title of the web page, the 
description of the web page and the URL to link to it. 

• Google also keeps a copy of the web page for itself. If the page 
is no longer available, click on cached next to the URL to open 
and use Google’s copy of the site. 

 
 Finding Similar Pages • If one of the results is exactly what you want, click on Similar 

Pages, next to cached, to pull up other pages like the one you 
selected. 

 
 
 
Additional Advanced Search Options 

Choosing a Language • The Advanced Search will return pages in any language.  
• To restrict results to one language, click on the down arrow 

next to that field and select the language. 
 

Selecting File Format 
Options 

• A powerful option in the advanced search is to restrict the 
search to a specific file format or to exclude that format from 
a search. 

• With the first down arrow next to the File Format field select 
Only or Don’t. 

• Then click the down arrow next to the second field to search 
for a specific file format. 

 
To Limit the Date  • If you are searching for material and would like to limit the 

results to only the most current or updated pages, use the Date 
field.  

• The down arrow, next to the date field, allows users to limit 
the search to a time frame for when the page was last updated. 

 
To Restrict a Search • The occurrences field allows users to tell Google where to look 

for the terms listed in the search boxes 
 
Using the Domain Feature • Using the domain features allows users to restrict a search to 

specific web site or type of site. For example, limiting a search 
to URL’s that end in edu will return results that are identify 
themselves as being a school. 

 
Filtering • Google provides the option to use a filter on searches to 

eliminate unwanted to material from the results. 
• Be aware that the filter is effective but not perfect! 
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How to Save Graphics from the Internet 
 

1. Find a graphic on the Internet that you would like to save. 
2. Right click on the image you would like to save and select Save Image As.  On the 

Mac just click and hold on the graphic and choose “copy to disk” 
3. Change to the appropriate drive.  A file name should appear.  Click Save.        
 
The graphic was either saved with a .GIF or .JPG extension.  In order to pull the graphic 
into some Windows programs (ClarisWorks 4.0, Student Writing Center, Kid Pix Studio), 
the file needs a .BMP extension.  You must open the file in a paint program which allows 
you to convert the graphic to a .BMP format.  Paint Shop Pro is one example of such a 
program.  Conversion is unnecessary if your program will accept graphics with a .GIF or 
.JPG extension.  ClarisWorks 5.0, Kid Pix Studio Deluxe, and HyperStudio will allow you 
to use graphics with a .GIF and .JPG extension.  The change is not necessary if you are 
inserting the graphic into Microsoft Word. 
 
4. Minimize Netscape. 
5. Open Paint Shop Pro. 
6. From the File menu, select Open. 
7. Select the appropriate drive and click on the graphic you just saved. Click  OK. 
8. The graphic should appear on your screen. 
9. Under the FILE menu, drag down to SAVE AS. 
10. Change the List Files of Type box to .BMP - Windows Bitmap. 
11. Click OK. 
12. Look on the Title Bar. The graphic should now have a file name that ends in .BMP. 
13. File, Exit. 
 
You should be able to pull your graphic into other programs.  This is a great way to 
create a graphics folder for a theme or unit of study. 
 
* You should get permission to use any graphics that you save or copy from the Internet 
in order to comply with copyright laws. 
 
How to Copy/Paste Graphics from the Internet 

 
You must use Microsoft Internet Explorer in order to copy/paste graphics from the 
Internet. Netscape will only let you SAVE the graphics--not copy and paste them. 
 
1. Open Microsoft Internet Explorer.  
2. Locate the graphic you wish to copy. 
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3. Right click on the graphic (on a Mac just click and hold).  A menu will appear. 
4. Choose Copy. 
5. A copy of the image is placed on the clipboard. 
6. Open the document in which you wish to paste the image. 
7. From the Edit Menu, choose Paste. 

 
Occasionally, using Internet Explorer to copy graphics from a PC results in a distorted 
image.  The colors don’t always paste into a document as they appeared on the Internet.  
In such cases, you should save the image from the Internet rather than copying and 
pasting.  You may then have to convert the graphic using Paint Shop Pro or some other 
draw program to a .bmp format in order to use it in your program. 
 
Copying and pasting is an easy way to get a quick graphic from the Internet.  If you’d 
like to create a graphics folder, you’ll need to save the graphics from the Internet 
rather than copying and pasting. 
 
* You should get permission to use any graphics that you save or copy from the Internet 
in order to comply with copyright laws. 
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How to Copy/Paste Text from the Internet 
 

1. Open Netscape or Internet Explorer. 
2. Locate the text you wish to copy. 
3. Highlight the text. 
4. From the Edit Menu, choose Copy. 
5. A copy of the text is placed on the clipboard. 
6. Open the document into which you wish to paste the text. 
7. Click to plant the cursor where you would like to paste the text. 
8. From the Edit Menu, choose Paste. 

 
Copying and pasting is an easy way to get text from the Internet. However, you should 
be mindful of copyright laws and give credit to the Web page from which you took the 
text. 
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How to Cite Resources from the Internet 
 
1. World Wide Web 
Structure: 
Author. Title of item. [Online] Available http://address/filename, date of document or download. 
Example: 
Schwartz, Robert. The Cold War Revisited: A Splintered USSR. [Online] Available 
http://usa.coldwar.server.gov/index/cold.war/countries/former.soviet.block/, November 1, 1998. 

 
2. Email/LISTSERVs 
Structure: 
Author of email message. Subject line of the message. [Online] Available email: Student@address.edu 
from Author@address.edu, date of document or download. 
Example: 
Rule, Christopher. Nile River Research Project results. [Online] Available email: 
student5@smallvillehigh.edu from ert@informns.k12.mn.us, October 2, 1998. 

 
3. Images/Graphics 
Structure: 
Description or title of image. [Online] Available http://address/filename, date of document or 
download. 
Example: 
Butterfly. [Online Image] Available http://www.kidsdomain.com/holiday/spring/clip.html/ butterfly.gif, 
October 23, 1998. 
 
4. Sounds 
Structure: 
Description or title of sound. [Online Sound] Available http://address/file, date of document download. 
Example: 
Reflections on Apollo. [Online Sound] Available ftp://town.hall.org/radio/ 
IMS/NASA/100394_nasa_01_ITR.au, September 25, 1998. 
 
5. Video Clips 
Structure: 
Description or title of video clip. [Online Video Clip] Available http://address/file, date of download. 
Example: 
Shoemaker-Levy Comet enters Jupiter’s atmosphere and breaks up. [Online Video Clip] Available 
ftp://ftp.cribx1.u-bordeaux.fr/astro/anim/s19/breakingup.mpg, September 5, 1998. 
 

 
Easy Bib -  http://www.easybib.com/  
Noodle Tools - http://www.noodletools.com/  
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Setting Up a iKeep Bookmark Account 
 

1. Go to http://www.ikeepbookmarks.com by typing it in the location box of your 
Internet browser.  Press the Enter or Return key. 

2. Click on Create a New Account.  

 
3. Type an account name. Your account name needs to be something that you can 

remember easily, such as the username that you use for your e-mail account. 
4. Enter an authoring password for your account.  You may want to use the same 

password that you use for your e-mail account so you can remember it. You will be 
asked to type the password a second time to confirm it. 

 
My Account Name: 
My Authoring Password: 
 

5. Click in the box next to Remember my Login to deselect that option on this 
computer if it is not a computer that you use exclusively. 

6. Choose Account Type from the drop down list. 
7. Click on Finished when you have completed the Contact Details at the bottom of 

the registration screen. The following screen will appear.  
8. Write the link to your account in your plan book or someplace so that you can get 

back to it easily. 
9. Click on option 2 to go to the home page for your account and to start adding links 

right away or option 1 to upload your links from your computer to your 
Ikeepbookmarks account. If you choose not to upload your bookmarks now, you 
can do so later. 

 
To Add Links to Your Account 
 
1. From the main page of your account click on Add. 
NEED AN IMAGE FOR THIS WITH AN ARROW 
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2. The following screen will appear. Type the title of the link. Copy and paste the 
URL for the link into that field making sure that there are not two http://s in 
the field.  
A description of the link is optional but useful when the numbers of links grows.  

 
 

3. When the information for the link is complete, click Finished at the bottom of 
the entry screen. 

 
Notice that the links automatically appear in alphabetical order. From the main page, you 
can choose a different arrangement for your links by changing the drop down box next 
to the Add button for the links. 
To Organize Bookmarks 
 

1. From the home page click Add right underneath the words “These buttons, 
below, allow you to add or edit folders.”  The following screen will appear. 

 
2. Type the name of the folder and when you are done click Finished. You can create 

separate folders for classes, subjects or topics or any grouping that you can think 
of. 

3. To add links into a specific folder, open the folder first before clicking the Add 
button. 

4. Or, if you already have links that need to be organized, click the Edit button next 
to the list of existing links. 
 
Click in the empty box next to the title of the link. A green checkmark will 
appear. 
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On the left-hand side in the gray box, change the Destination Folder to the one 
the link should move to then click on the Move button. 
When you are back at your home screen, a new number should appear next to the 
folder you moved links into. 

 
To Upload Bookmarks from a Computer 
 

1. On the top of the page, next to red Ikeepbookmarks.com logo, click on Bookmarks 
from the list of menu options. 

2. Two choices appear on the screen.  Click on Upload Bookmarks to the Web and the 
following screen will appear. 

 
 

 
3. Choose the first option to upload all the existing favorites from the web browser 

you are using to the bookmark folder. Simply click on the arrow and wait. A box 
will appear letting you know if it was successful. 

4. Other options on the upload page allow users to upload only  
new material or to replace existing bookmarks in the ikeep bookmarks account 
with the ones from the browser on the computer that you are using.  Choosing to 
use the replace option will wipe out your existing bookmarks in you account 
and put new ones from your browser in there.  

 
 

Optional Features 
 
The Options menu allows you to give people access to your bookmarks. Choose 
Options from the menu next to the red l Ikeepbookmarks.com logo at the top of 
the web page. Select a password for the visitor and set up the visitor’s access 
options. The Options menu will allow you to share your bookmarks without other 
people.  
 
The PopUp feature allows you to drag and drop links onto it while you are 
searching the web. Choose PopUp from the menu next to the red 
Ikeepbookmarks.com logo to find out how. 
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Software Helper 
Word Processing Basics with MS Word  

 
Formatting Text- Change the font, size, and style by clicking on Format and font or on 
the top tool bar. 
 
Spacing Text- Click on Format and Paragraph 
 
Bullets- To automatically start bullets, create an asterisk before your statement and 
then press return.  The next line will automatically make a bullet.  To create custom 
bullets, select the text you wish to appear bulleted.  Click on Format and Bullets and 
Numbering, Word will now insert bullets for the text that you selected. 
 
Viewing Options- 

 Normal gives you 100% 
 Online Layout helps you see other areas of your document at the same time. 
 Page Layout allows you to see the entire width of the page. 
 Outline allows you to see your document in an outline form. 
 Master Document allows you to organize and maintain a long document by dividing it 

up into sub documents. 
 
Viewing Toolbars- To see a toolbar that is not visible, click on View and Toolbar and 
select the toolbar that you wish to see. 
 
Header/Footers- Headers and Footers make it possible to have the same text appear on 
each page.  You can create a header and footer for your document by clicking on View 
and Header and Footer.  They can include both text and graphics and are great for page 
numbers, date, logo, etc. 
 
Page Numbers- Click on Insert and Page Numbers.  Choose your justification. 
 
Symbols- Click on Insert and Symbols to add symbols like ®™↓ and more! 
 
Columns- Great for newsletters!  Click on format and Columns.  Select the option that 
you want from the top and click on Line Between if you want Word to draw a line 
separating the columns. 
Footnotes- Put your cursor where you want the footnote to appear.  Click on Insert and 
Footnote.  Word automatically numbers your footnote and you can type in your text at 
the bottom of the screen. 



Technology Tools in the Secondary Social Studies & Language Arts Classroom       

   

Copyright © 2001-2006  i3 Inc.                         inspiring, innovative, instruction                                                       Day 2                      

51

 
Auto Format- Choose Auto Format from the Format menu.  Click on the type of 
document that you wish to replicate and click Auto Format now.  Word will now change 
the format of your document to match the pre-set preferences of the template that 
you chose. 
 
Style Gallery- Once your document is formatted, click on Style Gallery from the 
Format menu.  This gives you access to different designs for your document.  You can 
see a preview of each style in the box to the right. 
 
Inserting Text and Graphics: 
Adding Graphics- Click on Insert and Picture. 

 Clip Art- Choose this to look through the library of graphics within the program. 
 From File- Choose this to get art from a clip art disk or pictures that you have 

downloaded form the Internet. 
 Auto Shapes- This will allow you to choose pre-made shapes.  The button on the 

bottom of the drawing toolbar will do the same thing. 
 Word Art- Allows you to make banner-type headlines. 
 Chart- Make custom charts to add to your word processing document. 

Adding Text Boxes- This is useful if you are using many graphics and want to contain 
your text to a certain portion of the page.  You can size text boxes by clicking on the 
little boxes around the text. 
 
Drawing- You can draw your own shapes by clicking on the tools along the bottom of the 
screen on the drawing toolbar.  If your toolbar is not visible, click on View and Toolbars 
to select the drawing toolbar. 

 Draw: Click on the draw menu at the bottom to rotate, align or move shapes. 
 Arrow:  Click on the arrow to select clip art and graphics 
 Auto Shapes: This option allows you to create custom shapes 
 Line:  Create your own lines.  To make a line straight, press the shift key while you 

draw. 
 Arrow:  Allows you to draw arrows. 
 Rectangle/Oval Tools: Draws shapes.  To make a perfect circle or square, press your 

shift key while you draw. 
 Text Box: Creates a box for text.  You can move text boxes around like graphics and 

art. 
 Word Art Tool: Use this to make creative headings for your papers. 
 Fill Color: Create a fill color for shapes and graphics that you have created. 
 Paint Brush: This will change the color of lines that you draw. 



Technology Tools in the Secondary Social Studies & Language Arts Classroom       

   

Copyright © 2001-2006  i3 Inc.                         inspiring, innovative, instruction                                                       Day 2                      

52

 Font Color: Change the color of the font.  You will need to select the text before 
choosing the font color to change the existing text. 

 
Text Wrap- Choose Page Layout from the View menu.  Click on the graphic that you 
wish to wrap your text around.  Open the Format menu and select the type of graphic 
you are working with.  Click on the Wrapping tab and make your selection. 
 
Other Word Features: 
 
Wizards and Templates: Click on File and New to see the built in templates.  Click once 
on the document you wish to see and a preview will show on the right hand side of the 
screen.  Use wizards and templates for the following things: 

 Letters 
 Faxes 
 Memos 
 Resumes 
 Reports 

 
Keyboard Shortcuts: 
Use keyboard shortcuts for quick and easy access: 
 

Cut   Crtl + X 
Copy   Crtl + C 
Paste   Crtl + V 
Undo   Crtl + Z 
Select All  Crtl + A 
Bold   Crtl + B 
Italic   Crtl + I 
Underline  Crtl + U 
Left Align  Crtl + L 
Right Align  Crtl + R 
Center  Crtl + C 
Justify  Crtl + J 
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 Only hit return at the end of a paragraph. 

 
 Single spacing after punctuation.  

 
 Avoid using all caps. 

 
 Titles should be larger than the body of your document and can be in sans serif font.  

Be creative with your style. 
 

 Rarely underline.  Use italics for titles. 
 

 Use tabs to align text- not the space bar! 
 

 Indent or use space between the paragraphs- but not both. 
 

 Generally, use not more than two fonts on a page. 
 

 Use italic and bold as rich desserts- fine occasionally, but easy to overdose. 
 

 For signifying A.M. and P.M., use capital letters, periods, and font one size smaller 
than the rest of the document. 

 
 Avoid abbreviations in addresses, except for states. 

 
 Allow for white space in your document. 

 
 To avoid widows and orphans, try making your top and bottom page margins and/or 

your font smaller. 
 

 Use a spelling checker. 
 

 Always proofread a printed copy of your work. 
 

 Print a duplicate copy of your work in gray scale, so you can see how it will look if you 
plan to duplicate it on the copy machine. 
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Web Harvest Sheet 
 

Use this sheet to record URLs that you want to 
remember for later use. 

 
URL Title Description 

 
 
 
 
 
 

  

 
 
 
 
 
 

  

 
 
 
 
 
 

  

 
 
 
 
 
 

  

 
 
 
 
 
 

  

 
 
 
 
 
 

  

 
 
 
 
 
 

  

 
 
 
 
 
 

  

 
 
 
 
 
 

  

 


